# Revision History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Purpose for Change</th>
<th>Author</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>GA</td>
<td>D. Jecker</td>
<td>Oct 2019</td>
</tr>
</tbody>
</table>


## Contents

1. **About This Guide** ........................................................................................................ 1
   1.1 Related Documentation .................................................................................. 1

2. **Introduction** ........................................................................................................ 2
   2.1 Ocularis Database Format vs .avi format? .................................................. 2

3. **Where a Video Clip Originates** .............................................................................. 3
   3.1 Exported Results .......................................................................................... 4

4. **Getting Started** .................................................................................................... 5
   4.1 Launch the Ocularis Viewer ....................................................................... 5
   4.2 Exiting the Ocularis Viewer ....................................................................... 5
   4.3 Ocularis Viewer Version ........................................................................... 6

5. **Using the Ocularis Viewer** ..................................................................................... 7
   5.1 Load a Video Clip ....................................................................................... 7
   5.2 Ocularis Viewer Interface ......................................................................... 8
   5.3 Viewing Video ............................................................................................. 9
   5.4 Keyboard ShortCuts .................................................................................. 10
   5.5 Video Options ............................................................................................ 11

6. **Exporting** ............................................................................................................. 12
   6.1 To Export Video to .AVI Format ............................................................... 12
   6.2 To Export Video to Still Images (.jpg format) .......................................... 14
   6.3 Export Progress ......................................................................................... 16
   6.4 Printing ....................................................................................................... 17
List of Tables

Table 1-1: Related Documents ........................................................................................................ 1

List of Figures

Figure 1 The Export to Database Format Dialog Box ................................................................. 3
Figure 1 Ocularis Viewer .............................................................................................................. 5
Figure 2 About Ocularis Viewer ................................................................................................. 6
Figure 3 Ocularis Viewer with a 1 pane display ......................................................................... 7
Figure 4 Ocularis Viewer Interface ............................................................................................ 8
Figure 5 Ocularis Viewer Timeline ............................................................................................ 9
Figure 6 Export to AVI ................................................................................................................ 13
Figure 7 AVI Export Setup ....................................................................................................... 13
Figure 8 Export Complete Notification ..................................................................................... 14
Figure 9 Export Still Frames .................................................................................................... 15
Figure 10 Image Export Setup ................................................................................................. 15
Figure 11 Export Progress ........................................................................................................ 16
Figure 12 Print Report ............................................................................................................... 18
Figure 13 Preview of Print Report ............................................................................................ 19
1 About This Guide

This document describes how to use the Ocularis Viewer.

1.1 Related Documentation

Related documents are listed below.

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Version</th>
<th>File Type</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oculis 5.8 Release Notes</td>
<td>5.8</td>
<td>PDF</td>
<td>October 2019</td>
</tr>
<tr>
<td>Ocularis Client User Manual</td>
<td>5.8</td>
<td>PDF</td>
<td>October 2019</td>
</tr>
</tbody>
</table>

Add-on Documentation
2 Introduction

The Ocularis™ Viewer is a standalone application that allows users to view video clips exported from Ocularis™ Client. The exported video is in Ocularis database format. Users need not have the full featured Ocularis Client in order to view the encrypted video.

The Ocularis Viewer allows users to:

- View and playback video clips exported from Ocularis Client.
- Export additional clips from the original clip.
- Export still images from the original clip.
- Print reports based on images in the original clip.

2.1 Ocularis Database Format vs. .avi format?

There are situations where it is more beneficial to export video from Ocularis Client to Ocularis Database Format rather than to .avi format:

- .avi format supports only 1 camera stream per file. Ocularis Database Format supports multiple streams in the same file.
- Ocularis Database Format video supports file encryption for security
- Ocularis Database Format video supports password protection for security
- By using the Ocularis Viewer with Ocularis Database Format video, users have a fully functioning video application that goes beyond simply playing back video. You can print from the video clip or export additional clips to .avi format.
3 Where a Video Clip Originates

The Ocularis Viewer is used to view video evidence that is exported from Ocularis Client. The video is in proprietary format and contains an ".oml" file extension.

The Ocularis Viewer is used in lieu of having the Ocularis Client installed on the PC. It is available two ways:

1. When the Ocularis Client software is installed, the Ocularis Viewer application is also installed on the same workstation.

2. When a Database Format video clip is exported from Ocularis Client, the Ocularis Viewer may also be included as part of the export.

From the Ocularis Client Export Options screen, a user selects 'Database Format':

Figure 1 The Export to Database Format Dialog Box

The ‘Export Ocularis Viewer to same directory’ checkbox should be checked to include the Ocularis Viewer application as part of the export.
3.1 Exported Results

Once the export process is finished, the following will be found in the destination folder:

- a ‘[filename].oml’ file
- a folder named ‘Data’
- a folder named ‘Ocularis Viewer’ (if the option to ‘Export Ocularis Viewer to same directory’ checkbox was selected)
4 Getting Started

4.1 Launch the Ocularis Viewer

There are multiple ways to launch the Ocularis Viewer.

From a workstation with the Ocularis Viewer application installed (such as an Ocularis Client workstation):

- The Start menu: **Start ➔ All Programs ➔ OnSSI ➔ Ocularis Viewer (64-bit)**

From the exported video directory:

When database format video is exported, if the ‘Export Ocularis Viewer to same directory’ checkbox is checked, a sub-folder in the destination folder for the video will be created.

- From the Ocularis Viewer folder, double-click the **Ocularis Viewer.exe** file.

The Ocularis Viewer appears.

**Figure 2 Ocularis Viewer**

4.2 Exiting the Ocularis Viewer

There are two ways to exit the Ocularis Viewer.

- From the Menu, select **File ➔ Exit**
- Press the [Esc] key on the keyboard
4.3 Ocularis Viewer Version

To determine which version of the Ocularis Viewer application you are using:

- From the Menu, select **Help…About**

Figure 3 About Ocularis Viewer
5 Using the Ocularis Viewer

5.1 Load a Video Clip

To load a video clip:

1. Select the ‘File’ menu and click ‘Open’.
2. Locate the exported ‘.oml’ file, select it and click ‘Open’.
3. If a password is required for the video, you will be prompted to enter it. Enter the password and click OK.

The video clip is loaded and displays the first frame of the clip.

Figure 4 Ocularis Viewer with a 1 pane display

Only one clip may be open at a given time.
5.2 Ocularis Viewer Interface

The interface for the Ocularis Viewer is similar to that of Ocularis Client.

![Ocularis Viewer Interface Diagram]

**Menu Bar**

Items on the menu bar include the **File**, **Export**, **Options** and **Help** menus.

**View Console**

The View Console is the main display area. It will display recorded video. This area may display one or more panes of video depending on what was selected during the export.

**Navigation Controls**

Use these buttons to navigate and control the displayed video.

**OnSSI Viewer Timeline**

Used to manually control displayed video for all panes synchronously.

**Selected Pane**

If multiple panes are displayed, only one can be the active pane at any time. This is indicated by the blue outline around the active pane.
5.3 Viewing Video

Once the video clip is loaded (see ‘Load a Video Clip’ on page 7), navigate the video using the following:

1. Manually drag the Ocularis Timeline to the left and right. The color coding on the timeline follows the same conventions as Ocularis Client and is defined as follows:

   - Black: no video was recorded
   - Green: video was recorded, but no motion was detected
   - Red: video was recorded, containing motion events
   - Purple: indicates the future, starting from the current time

   Use the time scale icons on the Ocularis Timeline to increase or decrease the units of the timeline.

2. Navigation Buttons are defined as follows:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Left Arrow]</td>
<td>Skip one frame backwards</td>
</tr>
<tr>
<td>![Right Arrow]</td>
<td>Skip one frame forwards</td>
</tr>
<tr>
<td>![Previous Sequence]</td>
<td>Go to the previous sequence in the database</td>
</tr>
<tr>
<td>![Next Sequence]</td>
<td>Go to the next sequence in the database</td>
</tr>
<tr>
<td>![Beginning]</td>
<td>Go to the beginning of the database</td>
</tr>
<tr>
<td>![End]</td>
<td>Go to the end of the database</td>
</tr>
<tr>
<td>![Reverse]</td>
<td>Play in Reverse</td>
</tr>
<tr>
<td>![Forward]</td>
<td>Play forwards</td>
</tr>
<tr>
<td>![Specific Time]</td>
<td>Go to a specific time in the database</td>
</tr>
</tbody>
</table>

Even though only one pane of the video displayed can be the active pane at any time, all video will play (or rewind, etc.) synchronously for all visible panes, provided that recorded video exists.
Note: Video exported from a camera with a 360° lens will appear in its original 'warped' state when viewing with Ocularis Viewer. Use Ocularis Client to view this video as dewarped. See Viewing Exported Video from a Cameras with a Panomorph Lens in the Ocularis Client User Manual for details.

5.4 Keyboard ShortCuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Shortcut for:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + O</td>
<td>File…Open</td>
<td>Loads a video file</td>
</tr>
<tr>
<td>Esc</td>
<td>File…Exit</td>
<td>Closes the Ocularis Viewer</td>
</tr>
<tr>
<td>Ctrl + &lt;number&gt;</td>
<td>File…Recent Files…&lt;filename&gt;</td>
<td>Opens recently viewed files</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Export…AVI File</td>
<td>Exports a clip to .AVI format</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Export…Individual Frames</td>
<td>Export a jpg or series of jogs</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Export…Print</td>
<td>Print an incident report</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Export…Progress</td>
<td>View progress of an export</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Help…About</td>
<td>Displays the version of Ocularis Viewer</td>
</tr>
<tr>
<td>Left arrow</td>
<td></td>
<td>Previous Frame</td>
</tr>
<tr>
<td>Right arrow</td>
<td></td>
<td>Next Frame</td>
</tr>
<tr>
<td>Alt + Left arrow</td>
<td></td>
<td>Previous Sequence</td>
</tr>
<tr>
<td>Alt + Right arrow</td>
<td></td>
<td>Next Sequence</td>
</tr>
<tr>
<td>Ctrl + Alt + Left arrow</td>
<td></td>
<td>Go to beginning of database</td>
</tr>
<tr>
<td>Ctrl + Alt + Right arrow</td>
<td></td>
<td>Go to end of database</td>
</tr>
<tr>
<td>Ctrl + Left arrow</td>
<td></td>
<td>Play video in reverse</td>
</tr>
<tr>
<td>Ctrl + Right arrow</td>
<td></td>
<td>Play video forward</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td></td>
<td>Go to Time</td>
</tr>
<tr>
<td>[</td>
<td></td>
<td>Set start of export clip</td>
</tr>
<tr>
<td>]</td>
<td></td>
<td>Set end of export clip</td>
</tr>
<tr>
<td>+</td>
<td></td>
<td>Zoom the Timeline scale in</td>
</tr>
<tr>
<td>-</td>
<td></td>
<td>Zoom the Timeline scale out</td>
</tr>
</tbody>
</table>
5.5 **Video Options**

There are two settings which allow you to control the quality of the video. These are located in the ‘Options’ menu. These options help you control the playback speed of high resolution cameras.

5.5.1 **Scale to viewport size**

This option will scale an image down to the current size of that image’s view pane. For example, if the image resolution of a video is 1920 x 1080 and the view pane size for that image is 800 x 600, the displayed image will be scaled from 1920 pixels wide to 800 pixels wide. Note: Image resolutions are only scaled downward; they are not scaled up.

5.5.2 **Video Quality**

This option allows you to set the quality of the video to Low, Medium or High.
6 Exporting

While viewing video clips with Ocularis Viewer, you may find the need to export additional clips from the existing file. Exporting includes: export video to .avi format or export still images to .jpg format.

A Note About Video Codecs:
A video codec ("compression / decompression") is required to create .avi files. AVI is not in itself a codec; it is a common container format that many different codecs can use. There are literally hundreds of supported codecs.

Ocularis Viewer 64-bit only recognizes the Xvid codec. Xvid must be installed manually. You can download this free codec from the Xvid website or from the Ocularis Component Downloads page located on Ocularis Base.

6.1 To Export Video to .AVI Format

You can export video from the Ocularis Viewer to .avi format. Similar to exporting in the Ocularis Client, you must first set your start and end times for the video clip.

1. Load the source video using File…Open.
2. If the View Console contains multiple panes, select the pane with the video you wish to export.
3. Navigate to the desired start of the video clip.
4. Click the ‘Set Start of Export’ button.
5. Play the video / navigate to the end of the clip you wish to export.
6. Click the ‘Set End of Export’ button.
7. From the menu, select Export…AVI File.
8. In the Export to AVI File pop-up window, enter the entire path to the folder to store the video clip. Use the browse button to select via mouse.

9. Enter the Filename to assign to the clip. The filename entered will be appended with the .avi suffix.

10. Enter optional Preamble information for the clip. A Preamble is title text that appears in the clip prior to the actual video.

11. Enter a description in the Comment field regarding the incident. This optional text will appear in the video’s preamble.

12. If you would like to change default settings of the .avi video export, click the Setup button.

Figure 7 Export to AVI

Figure 8 AVI Export Setup
a. Here you can modify the settings as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Codec</td>
<td>Select alternate codecs from the drop-down list.</td>
</tr>
<tr>
<td>Encoding Quality</td>
<td>Choose: Low, Medium, or High. The higher the quality, the larger the size of the resulting file.</td>
</tr>
<tr>
<td>Include:</td>
<td></td>
</tr>
<tr>
<td>Time Stamp</td>
<td>Check this box to the time stamp displayed on the video while it is playing.</td>
</tr>
<tr>
<td>Camera Name</td>
<td>Check this box to display the camera name on the video.</td>
</tr>
<tr>
<td>Always Prepend Preamble</td>
<td>Check this box to include the preamble text to the video clip.</td>
</tr>
</tbody>
</table>

b. Click OK to save settings in the AVI Export Setup pop-up.

13. When ready, click Export. The clip will be stored in the location specified using the filename specified. When the export completes you'll see a toast notification appear briefly above the system tray that allows you to go to the folder in which the clip is stored or to open the clip using the default .avi media player.

Figure 9 Export Complete Notification

You may also view the video using any viewer which supports .avi.

6.2 To Export Video to Still Images (.jpg format)

You can export video from the Ocularis Viewer to a single or a series of still images. The image is saved in .jpg format.

1. Load the source video using File…Open.

2. If the View Console contains multiple panes, select the pane with the video you wish to export.

3. Navigate to the frame of the image you wish to export.
   a. If you wish to export multiple images:
- Navigate to the starting frame
- Click the ‘Set Start of Export’ button
- Navigate to the ending frame
- Click the ‘Set End of Export’ button

4. From the menu, select **Export…Individual Frames**.

**Figure 10 Export Still Frames**

5. In the **Export Still Frames** pop-up, specify the folder in which to store the image(s). Use the browse button  to select via mouse.

6. Select either Single Frame if exporting only one jpg. Select Full Timespan if you wish to export multiple .jpg images. (The Full Timespan option will only be available if a video clip was selected).

7. If you would like to change default settings of the .jpg image, click the **Setup** button.

**Figure 11 Image Export Setup**
Here you can modify the settings as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Quality</td>
<td>Choose: Low, Medium, or Original. The higher the quality, the larger the size of the resulting file.</td>
</tr>
<tr>
<td>Include:</td>
<td>Time Stamp: Check this box to display the time stamp on the image.</td>
</tr>
<tr>
<td></td>
<td>Camera Name: Check this box to display the camera name on the image.</td>
</tr>
</tbody>
</table>

Click **OK** to save settings in the *Image Export Setup* pop-up.

8. When ready, click **Export**.

The image(s) will be stored in the location you specified using the following filename convention:

```
YYYY-MM-DDTime_of_image_capture.jpg
```

You may now view the image(s) using any viewer which supports .jpg.

### 6.3 Export Progress

After you've issued an export command, you can check the status of the export's progress.

- From the Menu, select **Export...Export Progress**

An Export Progress screen appears.

Figure 12 Export Progress

If you have multiple exports, you'll see them all listed. The progress bar(s) on this screen identify how far along the export is.
When the export is complete, you will see a status message pop up in the system tray on the desktop.

- Click the **Folder** button to open the folder which contains the exported file using Windows Explorer.
- Click the **Open** button to open the exported file in the application associated with the file type.

### 6.4 Printing

Still Image Reports are printed reports which include a still image as well as the associated time, date, camera information, operator and workstation identifiers and operator comments.

#### 6.4.1 To Print a Still Image Report

1. Load the source video using **File…Open**.
2. If the View Console contains multiple panes, select the pane with the video you wish to export.
3. Navigate to the desired image to use in the report.
4. From the menu, select **Export…Print**.
5. Enter desired text for the report header in the *Header* field.

6. Enter any descriptive comments for the report in the *Comment* field. The text entered will automatically word wrap on the printed report.

7. Enter desired text for the report footer in the *Footer* field.

8. Click the **Preview** button if you would like to see a preview of the printed report.
9. Close the window to exit the print preview.

10. Click **OK** to send the report to the printer.